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Downloading the Wavecrest Certificate

e Contact Technical Support at (321) 953-5351, Ext. 4 or support@wavecrest.net for the link to the
certificate file and download it.

¢ Note the location of the downloaded file (nokeywavecrest.crt) as it will be needed when installing
the Wavecrest Certificate.

Installing the Wavecrest Certificate Using Microsoft Internet Explorer 11/Google
Chrome 64

NOTE: The Chrome browser uses the same certificate settings as Internet Explorer.

1. Open your Internet Explorer or Chrome browser.
2. Continue with one of the following:
¢ InInternet Explorer, from the Tools menu, click Internet options.

e In Chrome, in the top-right corner, click the Customize and control Google Chrome icon.
Then click Settings.

e Scroll to the bottom and click Advanced.
e Under System, click Open proxy settings.

3. Click the Content tab.

General Security Privacy Content Connections Programs Advanced

Certificates

Use certificates for encrypted connections and identification.

Clear 550 state Certificates Publishers

AutoComplete

AutoComplete stores previous entries Settings
on webpages and suggests matches
for you.

Feeds and Web Slices
@ Feeds and Web Slices provide updated Settings
[ content from websites that can be
read in Internet Explorer and other
programs.

0K Cancel Apply
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4.

5.
6.

10.

Click Certificates and then click the Trusted Root Certification Authorities tab.

Intended purpose: <All= w

Intermediate Certification Authorities

Trusted Root Certification Authorities

Trusted Publ * | *

Issued To Issued By Expiratio...  Friendly Name =
@Ceriﬂm CA Certum CA 6/11/2027  Certum

[Zlcertum Trusted Me...  Certum Trusted Metw...  12/31/2029  Certum Trusted ...
@Class 2 Primary CA Class 2 Primary CA 7iaf2019 CertPlus Class 2 ...
[IClass 3 Public Prima... Class 3 Public Primary ...  8/1/2028 VeriSign Class 3 ...
@COMODO RSA Cert..., COMODO RSA Certific... 1/18/2038 COMODO SECU...
[Zlcopyright (<) 1997 ... Copyright (c) 1997 Mi...  12/30/1999 Microsoft Timest...
@Digitert Assured ID... DigiCert Assured IDR... 11f9/2031  DigiCert

|ZDigicert Global Roo...  DigiCert Global Root CA 11/9/2031  DigiCert

@Digitert Global Roo... DigiCert Global Root G2 1/15/2038  DigiCert Global R...

Import... Export... Remove

Certificate intended purposes
Server Authentication

View

Cloze

Click Import. The Welcome to the Certificate Import Wizard dialog box is displayed.
Click Next. The File to Import dialog box is displayed.

File to Import
Spedfy the file you want to impart,

File name:

C:YTempi\nokeywavecrest.ort | | Browse. ..

Mote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS £12 (PFX,.P12)
Cryptographic Message Syntax Standard- PECS #7 Certificates ((P7E)

Microsoft Serialized Certificate Store ((55T)

Click Browse to locate the downloaded certificate file. An Open dialog box is displayed.
Locate and select the certificate file.

Click Open. The File to Import dialog box displays the File name field populated with the path of
the certificate file.

Click Next. The Certificate Store dialog box is displayed.
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Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
(®) Flace all certificates in the following store

Certificate store:
| Trusted Root Certification Authorities Browse. ..

11. Select the Place all certificates in the following store option, and click Browse to select
Trusted Root Certification Authorities. Click OK.

12. Click Next. The Completing the Certificate Import Wizard dialog box is displayed.

Completing the Certificate Import Wizard

The certificate will be impaorted after you dick Finish.

You have spedfied the following settings:

0= ) = | e e = mi=a ey B = Trusted Root Certification Authaorities

Content Certificate
File Mame C:\Tempinokeywavecrest.ort

13. Click Finish. A Security Warning dialog box is displayed.

14. Click Yes to install the certificate. A dialog box is displayed indicating that the import was
successful.

15. Click OK. The Wavecrest Computing certificate is listed in the Trusted Root Certification
Authorities tab.

16. Click Close to close the Certificates dialog box.

17. Click OK to close the Internet Options dialog box.

Installing the Wavecrest Certificate Using Mozilla Firefox 58
1. From the Firefox menu, click Options.
2. Click Privacy & Security and then scroll down to the Certificates section.
3. Click View Certificates. The Certificate Manager dialog box is displayed.
4. Click the Authorities tab.
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Certificate Manager b

Your Certificates People Servers Authaorities Others

You have certificates on file that identify these certificate authorities

Certificate Name Security Device "B
~wAC Camerfirma S.A. 2
Chambers of Commerce Root - 2008 Builtin Object Token
Glebal Chambersign Root - 2008 Builtin Object Token

~AC Camerfirma SA CIF AB2743287

Camerfirma Chambers of Commerce Root Builtin Object Token
Camerfirma Global Chambersign Root Builtin Object Token
wACCY
ACCVRAIZT Builtin Object Token
wActalis 5.p.A./03358520067
Artalic Avthenticatinn Ront CA Ruiltin Ohiert Taken &2
View... Edit Trust... Import... Export... Delete or Distrust...

OK

5. On the Authorities tab, click Import.
6. Locate and select the certificate file.

7. Click Open. The Downloading Certificate dialog box is displayed.

You have been asked to trust a new Certificate Authority (CA).

Do you want to trust “Wavecrest Computing, Inc. Primary EV Certificate Authority” for the
following purposes?

Trust this CA to identify websites.
[] Trust this CA to identify ernail users.
[] Trust this CA to identify software developers.

Before trusting this CA for any purpose, you should examine its certificate and its policy and
procedures (if available),

View Examine CA certificate

Cancel

8. Select Trust this CA to identify websites and click OK.
9. Click OK to close the Certificate Manager dialog box.

10. Close the Options tab in Firefox.

Importing the Wavecrest Certificate Using Active Directory

1. On the Active Directory server, from the Start menu, select Administrative Tools and then Group
Policy Management.
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5

File

Ackion  Wiew  Window Help

l«» | am| B2 mE

% Group Policy Management
EIA Forest: Wavecave.lan

R

Sites

G Group Policy Modeling
'E Group Policy Resulks

EIEGroup Policy Management M=l 3
| =181 x|
Domains
Contents |
Domain = | Current Domain Controller
Wavecave.lan Gaels.Wavecave.lan

2. Double-click the Domains folder, your domain name, and the Group Policy Objects folder.

s File

& s Group Policy Management

Action  Wiew  Window  Help

= A bae XE|2m

&
[
[
A
B

H
H

Er'j‘g Group Policy Management
Elﬁ Forest: Wavecave.lan
EI@ Domains

EE@ Wavecavelan

Appliance Test

g CertPushTest
-} Defaulk Domain Policy

-[&8 Domain Contrallers
r,ﬁl Internet Access Group
-[&3] Microsoft Exchange Security Groups

-{£3] Test AD
r,ﬂ‘"l W avecrest Camputing

[—]--% Group Policy Objects

Appliance Test
- ApplTest
- Cert install
e ushTes!
- Cyhblock setti
- Defaulk Domain Contrallers Palicy
- Defaulk Domain Policy
[ MSTinstallTest

ay

CertPushTest
Scope I Detailsl Settingsl Delegationl
Links

Display linkz in this location:

IWavecave.Ian

The following sites, domainz, and Ols are linked to this GPO:

Location = I Enforced I Link Enabled | Fath
[ Support Mo Mo Wwavecave.lan
@ Wavecave.lan No Yes Wavecave.lan

Security Filtering

The zettings in thiz GPO can only apply to the following groups, users, and computers:

Mame = I
-ﬁi Authenticated Users

3. Right-click your Group Policy object (e.g., CertPushTest) and select Edit. The Group Policy
Object Editor is displayed.

File

action  Wiew  Help

'{iii Group Policy Object Editor

«= | Bm e @R 2E

Z§ CertPushTest [Gaels, Wavecave.lan] Palicy
El@ Campuker Configuration

(L7 Software Settings

EI[:l Windows Settings

|| Scripts {Startupishutdown)

i Securiby Settings

+ Account Policies

Local Policies

Event Log

8 Restricted Groups

{3 Swskem Services

{E Reqgistry

(8 File Swstem

‘Wirgless Metwark (IEEE G021

E| [C7 Public kev Policies

[Z3 Encrypting File Syskem
[Z1 Automatic Certificate Rec

sked Fio

‘[ Enterprise Trust

Issued Ta  / | Issued B | Expiratio

Wavecrest Cornputing, Inc, Prima..,  “Wavecrest Computing, Inc, Primary ... 111220
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4. Under your Group Policy object, double-click Computer Configuration, Windows Settings,
Security Settings, and then Public Key Policies.

5. Right-click Trusted Root Certification Authorities, select All Tasks and then Import. The
Welcome to the Certificate Import Wizard dialog box is displayed.

6. Click Next. The File to Import dialog box is displayed.

File to Import
Spedfy the file you want to import.

File name:

C:¥Temp\nokeywavecrest.ort | | Browse, ..

Mote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (P7B)

Microsoft Seriglized Certificate Store ((S5T)

7. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed.
8. Locate and select the certificate file.

9. Click Open. The File to Import dialog box displays the File name field populated with the path of
the certificate file.

10. Click Next. The Certificate Store dialog box is displayed.

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate,

() Automatically select the certificate store based on the type of certificate
(®) Flace all certificates in the following store

Certificate store:
| Trusted Root Certification Authorities Browse. ..

11. The Place all certificates in the following store option is selected by default, and the
Certificate store field is populated with “Trusted Root Certification Authorities.”

12. Click Next. The Completing the Certificate Import Wizard dialog box is displayed.
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Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have spedfied the following settings:

0 o= e o = = s B Trusted Root Certification Authorities

Content Certificate
File Mame C:\Tempinokeywavecrest.ort

13. Click Finish. A dialog box is displayed indicating that the import was successful.

14. Click OK. The Wavecrest Computing certificate is listed in the Group Policy Object Editor.

Installing the Wavecrest Certificate in Windows 7 Professional/Enterprise

1. From the Start menu, type mmc in the search box, and press Enter. The Console window is
displayed.

E Consalel - [Console Roat]
[aFiIe Action  Wiew  Favorites  Window  Help

&= |E = HE

| Console Roat Marme

There are no items to show in this wview,

Action

Consg

2. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box is
displayed.
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Add or Remiove Snap-ins [

‘aou can select snap-ins For this console From those available on wour computer and configure the selected set of snap-ins. For
extensible snap-ins, vou can configure which extensions are enabled,

Available snap-ins: Selected snap-ins:

Snap-in Yendor E | Console Rook Edit Extensions. ..

%Active Direckory Do, Microsaft Cor..,

~ = Remove
Apr Active Directory Site,., Microsoft Cor,., |~
: Active Direckary Use... Microsoft Cor... L
- Activer Cantral Microsoft Cor... Mave Lip
[ ADsI Edit Microsaft Cor... e
4 Autharization Manager  Microsoft Cor... @ il
5] Certificate Templates  Microsoft Cor..,
5l Certificates Microsoft Car..,

LsICertification Authority  Microsoft Cor..,.,
2, Camponent Services Microsaft Cor...
;,‘; Computer Managem... Microsoft Cor,.,

gy Device Manager Microsoft Car..,
‘;n'_DFS Management Microsoft Car...  _ advanced. ..
Drescription:

The Certificates snap-in allows you to browse the contents of the certificate stores For wourself, a service, or a computet,

I oK |I Cancel ]

3. Under Available snap-ins, select Certificates and click Add. The Certificates snap-in dialog box
is displayed.

Certificates snap-in 2

Thizs snap-in will akways manage certificates for:
@ My user account
) Service account

) Computer accaount

< Back I Finish I[ Cancel ‘

4. Select My user account and click Finish. Certificates - Current User is displayed under
Selected snhap-ins in the Add or Remove Snap-ins dialog box.

NOTE: You may select the Computer account option to manage the certificate for the computer
account for all users.
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Add or Remove Snap-ins @

You can select snap-ns for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins; Selected snap-ns:
Snap-n Vendar - “| Console Root Edit Extensions. ..
- ActiveX, Control Microsoft Cor... '?‘IJ Certificates - Current User S
Aumorizaﬁon Manager Microsoft Cor... =
G Certificates Microsoft Cor... |z

CH Component Services Microsoft Cor...
$ Computer Managem... Microsoft Cor...

g=n Device Manager Microsoft Cor...

=4 Disk Management Microsoft and. ..
E Event Viewer Microsoft Cor...
| Folder Microsoft Cor...

'=[ Group Policy Object ... Microsoft Cor...
@ IP Security Monitor Microsoft Cor...
@ IF Security Policy M...,  Microsoft Cor...

£ Link to Web Address ~ Microsoft Cor...  _

Description:
The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer,

[ OK ] [ Cancel

5. Click OK. Certificates - Current User is displayed in the Console Root folder.

Consolel - [Console Rooth\ Certificates - Current User\Trusted Root Certification Authoritiesh Certificates] EI@
File Action View Favorites Window Help —[l&| =
e z@o8lc=HE
| Console Root Issued To ‘ Issued By Expiratic * || Actions
“F C_e’tp'f"ates ; Current User (5 AddTrust External CA Root AddTrust External CA Root 530/20) ||| Certificates  ~
- ersona - » [ Baltimore CyberTrust Root Baltimore CyberTrust Root 5/12/20 Mare »
4 || Trusted Root Certification Authorities JC " A Cert ca 6/11/20
- ol Certum ertum A1/
_| Certificates - o

[ Class 3 Public Primary Certificat... Class 3 Public Primary Certificatio... 8/1/202
[ Class 3 Public Primary Certificat... Class 3 Public Primary Certificatio...  1/7/200

_| Enterprise Trust
_| Intermediate Certification Authorities

6. Double-click Certificates - Current User and then Trusted Root Certification Authorities.

7. Right-click Certificates, and select All Tasks and then Import. The Welcome to the Certificate
Import Wizard dialog box is displayed.

8. Click Next. The File to Import dialog box is displayed.
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Certificate Irmport Wizard 22 |

File to Import

Specify the file wou want to import,

File narne:

Browse. ..

Mate: More than one certificate can be stored in a single file in the Following Formats:
Personal Infarmation Exchange- PKCS #12 (. PFX,.P12)
Cryptographic Message Svntax Standard- PKCS #7 Certificates {.P7E)
Microsoft Serislized Certificate Store {.55T)

Learn more about certificate file Formats

[ < Back “ Mexk = I[ Cancel ‘

9. Click Browse to locate the downloaded certificate file. An Open dialog box is displayed.
10. Locate and select the certificate file.

11. Click Open. The File to Import dialog box displays the File name field populated with the path of
the certificate file.

12. Click Next. The Certificate Store dialog box is displayed.

Certificate Irmport Wifizard 33

Certificate Store

Certificate stores are swstem areas where certificates are kept.

wWindows can automatically select a certificate store, or wou can specify a location For
the certificate.

~ Automatically select the certificate store based on the type of certificate
@ Place all certificates in the Follawing store

Cettificate stare!

Trusted Root Certification Authorities Browse. ..

Learn more about certificate stores

| « Back “ Mext = || Cancel |

13. The Place all certificates in the following store option is selected by default, and the
Certificate store field is populated with “Trusted Root Certification Authorities.”

10
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14. Click Next. The Completing the Certificate Import Wizard dialog box is displayed.

Certificate Import Wizard IEI
Completing the Certificate Import
Wizard
L | The certificate will be imported after you dick Finish.
& |
&8
'*'.-:_-':_V'I You have spedified the following settings:
Certificate Store Selected by User RISl 4o il
Content PFX
File Mame ¥i\development\Waw
] 1 3
[ < Back ][ Finish ] [ Cancel ]

15. Click Finish. A Security Warning dialog box is displayed.

16. Click Yes to install the certificate. A dialog box is displayed indicating that the import was
successful.

17. Click OK. The Wavecrest Computing certificate is listed in the Trusted Root Certification
Authorities, Certificates folder.

SSL Inspection

Now that you have installed the Wavecrest Certificate, you may proceed to use the SSL Inspection
screen in the product.

NOTE: By enabling SSL Inspection, applications using HTTPS communication and not utilizing Windows
Certificate Stores for certificate validation may encounter errors. Contact Technical Support for assistance
at (321) 953-5351, Ext. 4 or support@wavecrest.net.

11


mailto:support@wavecrest.net

& &

WAVECREST

COMPUTING

Wavecrest Computing

904 East New Haven Avenue
Melbourne, FL 32901
toll-free: 877-442-9346
voice: 321-953-5351

fax: 321-953-5350

All specifications subject to change without notice.
© Copyright 2018 Wavecrest Computing

www.wavecrest.net
Incorporated. All rights reserved.




	Downloading the Wavecrest Certificate
	Installing the Wavecrest Certificate Using Microsoft Internet Explorer 11/Google Chrome 64
	Installing the Wavecrest Certificate Using Mozilla Firefox 58
	Importing the Wavecrest Certificate Using Active Directory
	Installing the Wavecrest Certificate in Windows 7 Professional/Enterprise
	SSL Inspection

